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DISCLAIMER 

 

The contents of this manual do not necessarily reflect the official views or policies of the Indiana 

Department of Transportation (INDOT). The details in this manual are intended for reference 

only, not as specifications or design guidance. In the event that any information presented herein 

conflicts with the Indiana Design Manual, INDOT Standard Specifications or other INDOT 

policy, said policy will take precedence. 
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1 INTRODUCTION 

The design software “INDOT SEAL COAT DESIGN (iSeal)” was developed to aid the seal coat 

design process and incorporate INDOT seal coat practice. The software is largely based on the 

McLeod design method. Furthermore, one additional factor, an equipment factor, was 

implemented into the design process to resolve issues due to discrepancies between the designed 

rate and the applied rate. 

During development, engineers emphasized intuitiveness in using the software, thus providing 

more user-friendly software. In addition, the software provides various options when inputting 

values, namely “User-Defined”, “Typical” and “Measured”. “User-defined” allows a user to 

manually input desired values while “Typical” provides selection of generally accepted values 

for a given factor. “Measured” accepts experiment data and then converts this into a 

corresponding value. 
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2 INSTALLLATION GUIDE 

2.1 BEFORE INSTALLING 

iSeal was developed using ADOBE Flex technology and requires ADOBE AIR 2.6 to run the 

application. You can download ADOBE AIR 2.6 or newer version from http://get.adobe.com/air/. 

In addition, you need to check that your computer has the following minimum requirements to 

run iSeal: 

Windows 

 Intel®  Pentium®  4 processor 

 Microsoft®  Windows®  XP Home, Professional, or Tablet PC Edition with Service Pack 

2 or 3, Windows Server®  2003 or later 

 512MB of RAM 

Apple 

 Intel®  Core®  Duo 

 Mac OS X v.10.4.9 or later 

 512MB of RAM 

Linux 

 Intel®  Pentium®  4 processor  

 Fedora®  Core 12, Ubuntu®  v. 9 or later, or openSUSE®  v.11.2 or later 

 512MB of RAM 

  

http://get.adobe.com/air/
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2.2 INSTALLING ISEAL 

To install iSeal, follow these steps: 

1. Before you can install iSeal, you will need to download ADOBE AIR 2.6 or newer 

version and install it. If you have already done this, you can skip this step. 

2. Download iSeal installer from TBD. The iSeal installer icon should appear on your 

desktop, similar to the one below: 

 
3. Run iSeal Installer by double-clicking on the iSeal_Install icon on your desktop. An 

application install status window should appear followed by an application install 

window. Click the Continue button to continue.  
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4. You will be asked whether ADOBE AIR to be installed or not if you have not already 

installed ADOBE AIR in your computer. Click the I Agree button to continue. 

 

 

5. You will then have to specify the installation location and click the Continue button. 
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6. You have finished installing iSeal and an iSeal icon shown below should now appear on 

your Windows desktop. 
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3 OVERVIEW 

iSeal consists of five tabs, namely General, AAR, EAR, Summary and Attachments. 

In addition, iSeal features a status indicator and application menus. 

3.1 APPLICATION MENU 

Application menus are located in the upper left corner of the window and consist of File, View 

and Help. 

 

3.1.1 FILE 

The figure below illustrates the File menu.  

 
 New: Opens a new sheet. Up to five sheets can be opened at the same time (Keyboard 

shortcut CRTL + N). 

 Open: Opens the selected file (Keyboard shortcut CRTL + O). 

 Save: Saves the current work to a folder on your hard disk. The name of the file is 

automatically generated as Date_Time.indot and the default file save location is set to 

your computer’s desktop. Once the file is saved, it saves the current work to a existing 

saved file (Keyboard shortcut CRTL + S). 

 Save As: Saves the current work to a folder on your hard disk. The name of the file is 

automatically generated as Date_Time.indot and the default file save location is set to 

your computer’s desktop (Keyboard shortcut CRTL + A). 

 Save As: Closes the current sheet. (Keyboard shortcut CRTL + W) 
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 Exit: Closes the entire program. If there are multiple sheets, it closes them all at the 

same time (Keyboard shortcut CRTL + Q). 

3.1.2 VIEW 

The figure below illustrates the View menu. This allows a user to switch between different tabs 

and displays the keyboard shortcuts designated for each tab. 

 

 

3.1.3 HELP 

The figure below illustrates the Help menu. This provides the manual and software version 

information. 
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3.2 MULTIPLE SHEETS 

iSeal allows a user work with a number of sheets (up to five). And a user can easily switch 

between sheets in iSeal using either their keyboard shortcut (CTRL + Tab) or mouse by clicking 

on an individual sheet. 

The figure below illustrates how multiple sheets are shown in iSeal along with their file name. 

The current sheet is indicated by darker color.   
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3.3 STATUS INDICATOR 

The status indicator is located in the lower left corner of the window and provides an overview 

of required inputs. The figure below illustrates how the status indicator displays once any change 

in the values of each required input is detected. It is advised that a user verify their inputs on the  

“Summary” tab since the status indicator does not check the validity of the input value.  
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3.4 TAB 

3.4.1 GENERAL 

The “General” tab is the default screen when the software is launched. This allows a user to input 

general information regarding specific seal coat design, including designer information and 

location along with existing pavement condition and material type and source. The District and 

Sub-district features are Indiana’s, and existing pavement type selections are constructed based 

on the Indiana Design Manual Chapter 52 (1). 
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3.4.2 AAR 

The “AAR” tab presents a user to input values required to calculate the aggregate application 

rate, including Median Particle Size, Flakiness Index, Loose Unit Weight, Dry Bulk Specific 

Gravity, Wastage Factor and Equipment Correction Factor. The “Typical” input option in the 

median particle size box allows a user to select among widely used sizes of aggregates, such as 

Indiana aggregates No. 11, No. 12 and SC-16. Upon selection, the software inputs the median 

particle size accordingly; values are based on INDOT Standard Specification (2). The values for 

Flakiness Index generally range from 10 to 25 %. Loose Unit Weight and Dry Bulk Specific 

Gravity should be obtained under AASHTO T 19 (3) and T 85 (4). Although the last two factors, 

which are a wastage factor and an equipment correction factor, are optional, it is strongly advised 

that the user apply these factors. 
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3.4.3 EAR 

The “EAR” tab allows a user to input values required to calculate the emulsion application rate, 

including Traffic Factor, Surface Condition Factor, Absorption and Asphalt Content of Emulsion. 

Traffic factor is calculated based on the average daily traffic of the road. The Traffic Factor 

contributes significantly in designing EAR since it determines the average embedment depth, 

which ranges from 60 to 85 % of the average least dimension of aggregates. The Surface 

Condition Factor features five pictures to help a user determine the existing pavement condition 

and improve objectivity when selecting categories. The input value for Absorption is the water 

absorption of aggregates, although aggregate is mixed with emulsion in a seal coat application. 

This is mainly due to lack of testing methods that can measure the actual amount of emulsion 

absorbed by aggregates. The “Typical” input option is also available under the Asphalt Content 

of Emulsion box, which allows a user to select among widely used types of emulsion, namely 

RS-2, RS-2P, AE-90S and HFRS-2. Upon selection, the software inputs the asphalt content of 

the emulsion accordingly; values are based on INDOT Standard Specification (2). 
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3.4.4 SUMMARY 

The “Summary” tab presents all input values as a summary and instantly updates as any changes 

occurs in selected values. A small box featured in the right side of each line displays which type 

of value is used for each type of factor. AAR and EAR are also automatically calculated and 

displayed once the required data are defined in the software and update once any change in the 

value of each factor is detected. The “Summary” tab also features a “Print Report” option button 

in the left lower corner of the window, which allows a user to print detailed report. A detailed 

report shows every value input by a user and step-by-step calculation of the AAR and EAR in 

PDF format. The figures below illustrate how “Summary” tab displays type of factor as well as 

AAR and EAR.  
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3.4.5 ATTACHMENTS 

The “Attachments” tab displays a list of attached files. This feature essentially works the same 

way as attaching a file to an email. Furthermore, it provides a drag and drop function, which 

allows a user to simply drag any file to a software window and automatically the file in that 

location. This feature also provides options to manage multiple files at once by selecting the 

check box located in the lower left corner of the window. 
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4 GETTING STARTED 

4.1 LAUNCHING iSeal 

Run iSeal by double-clicking on the iSeal icon on your desktop or  

 
in your Windows Start menu. 
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4.2 DESIGN EXAMPLE 

The following example illustrates how to design AAR and EAR using iSeal step by step. 

Procedures presented in this example are designed to help the first-time user to become more 

familiar with iSeal, but hereafter a user may enter and edit values for each required input in any 

order. 

4.2.1 STEP 1 

Enter designer name along with design date and DES number. 
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4.2.2 STEP 2 

Enter location information, including existing pavement type and condition. Lane miles are 

automatically calculated once reference points are presented. 

 

 
 

For district selection, the user can choose from one of six districts of Indiana. Once a district is 

selected, a list of subdistricts corresponding to the selected district becomes available. 
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4.2.3 STEP 3 

Enter material information and additional comments in the blank space provided.  

For aggregate and emulsion type selection, a user can only choose from the list provided, based 

on INDOT Standard Specification (2). Indiana aggregate No. 11 and AE-90S are selected in this 

example. 
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4.2.4 STEP 4 

Enter the median particle size of aggregates used for the seal coat application using one of three 

input options. 

 

Option 1: User Defined 

Input median particle size by typing in values in the box or using arrows. 

 

 
 

Option 2: Typical  

Input median particle size by selecting one of five types of aggregate size. 
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Option 3: Measured  

Input median particle size by providing the sieve analysis result. 
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4.2.5 STEP 5 

Enter Flakiness Index of aggregates used for seal coat application using one of two input options. 

 

Option 1: User Defined 

Input Flakiness Index by typing values in the box or using arrows. 

 

 
 

Option 2: Measured 

Input Flakiness Index by providing the test result. 
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4.2.6 STEP 6 

Enter loose unit weight of aggregates used for seal coat application using one of two input 

options. 

 

Option 1: User Defined 

Input loose unit weight by typing in values in the box or using arrows. 

 

 
 

Option 2: Measured 

Input loose unit weight by providing the test result specified by AASHTO T 19 (3). 
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4.2.7 STEP 7 

Enter the bulk specific gravity of aggregates used for seal coat application. AASHTO T 85 

covers determination of the specific gravity of coarse aggregate (4). 

 

 

4.2.8 STEP 8 

Choose whether the wastage factor or equipment correction factor is used in the seal coat design. 

Findings from the study SPR-3087 recommend using both factors.   
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4.2.9 STEP 9 

Select one of five categories of average daily traffic for road segments on which the seal coat 

will be applied. 
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4.2.10 STEP 10 

Select one of five categories of surface condition for road segments on which the seal coat will 

be applied. 
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4.2.11 STEP 11 

Enter the water absorption of aggregates used for the seal coat application. AASHTO T 85 

covers determination of water absorption of coarse aggregate (4). 
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4.2.12 STEP 12 

Enter the asphalt content of the emulsion used for the seal coat application using one of two 

input options. 

 

Option 1: User Defined 

Input the asphalt content of the emulsion by typing values in the box or using arrows. 

 

 
 

Option 2: Typical  

Input the asphalt content of the emulsion by selecting one of four types of emulsions specified in 

the INDOT Specification. 
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4.2.13 STEP 13 

Review the input values. iSeal generates the AAR and EAR once the necessary input values are 

presented. 
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4.2.14 STEP 14 

If you would like to print a detailed report that contains general information as well as each step 

of the seal coat design calculation, click the Print Report button located at the bottom of the 

window. iSeal will generate a report in PDF format. 
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4.2.15 STEP 15 

The user can attach any type of file with no size limit. The figure below illustrates how to add or 

delete attached files. 

 

To add files, follow these steps: 

1. Click the Attach a File button. 
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2. Select a file and then click Open. 
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To delete files, select files by clicking the box, then click the Delete button 

 
  

1 

2 
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4.2.16 STEP 16 

The last step is to save your work. You can save your work at anytime by typing the keyboard 

shortcut CTRL + S. 

To save your work, follow these steps: 

1. Click the File button. 

 

2. Click either the Save or the Save As. 
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